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Disclaimer

The information in this workshop is distributed on an “as is” basis, without warranty. Although every
precaution has been taken in the preparation of this work, neither the author(s) nor IEEE shall have any
liability to any person or entity with respect to any loss or damage caused or alleged to be caused
directly or indirectly by the information contained in this work.
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Introduction — IEEE/CETA Robotics Workshop

Robot design and fabrication is an extremely rewarding and exciting activity for students of all ages.

Targeting high-school computer engineering technology teachers, this hands-on workshop uncovers the
basic principles involved in construction and programming of a simple autonomous line following robot.
The activity satisfies many aspects of the Ontario’s TEJ/ICS curricula, and it is hoped that the teacher will
be equipped to integrate this activity into his/her TEJ/ICS curriculum activities and also to field a team to
compete in the annual CETA (Computer Engineering Teachers Association — Dufferin-Peel) Regional
Robotics Competition.

The robot platform is based on a modern 16-bit microcontroller (PIC24), and is programmed using
standard tools and languages used in industry. The robot platform provides a cost effective system for
exploration of a variety of topics in TEJ/ICS curricula, such as analog/digital interfacing, motor control,
computer networking, embedded control & mathematical algorithms, as well as both C and assembly
language programming.

Training Objectives:

After the workshop the attendee shall,

e be able to develop embedded control C programs for the PIC24 MCU,

e be able to fabricate the robot platform used in the CETA competition,

e be able to configure the MCU inputs and outputs required for the robot,

e be able to implement a basic line-following control algorithm used in the CETA competition

The training consists of 5, 1-day modules, each of which consist of a PowerPoint presentation, with a
corresponding instructional lab manual and lab projects. All materials are provided on the student

CDROM.

Workshop Outline (Summary):

Day 1. How to Program in C—Day 1

Day 2. How to Program in C— Day 2

Day 3. How to Build the Robot Platform

Day 4. How to Program the Inputs and Outputs
Day 5. How to Control the Robot

Prerequisites:

You should ideally have some basic experience in electronics prototyping as well as microcontroller
programming, and be aware of basic safety rules when working with electronics.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Objective (Day 4)

The objective of this module is to cover the fabrication and basic programming of the electronic controls
for the robot.

Training Objectives:

After this module, the attendee shall,

e understand the PIC24 Architecture and Programmer’s Model, and how to create embedded C
programs for it, using Microchip’s embedded development tools,

e be able to fabricate the basic electronic control circuit for the robot,

e be able to write a program to drive a small DC motor,

e be able to modify the program to accept optical sensor input to detect a line

Detailed Outline:

Robot Platform

Firmware Development

Lab 1 — Wiring the Board

16-bit PIC® Architecture & Programmer’s Model
MPLAB® C for PIC24 Compiler Overview
C-Language Extensions for the PIC24

Lab 2 — Creating PIC24 C Projects in MPLAB
Working with Digital Input and Output Ports
Basics of Brushed DC Motors and Their Control
PIC24 Timer & Pulse-Width Modulation Peripherals
Lab 3 — Motor Control using the PWM Peripheral
Introduction to Sensors and Analog Signals
Optical Sensors used in Line Following Robots
Analog-to-Digital Converter Peripheral

Lab 4 — Line Detection Using the ADC

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Release Notes

v001 Summary (11 Feb 2011):

— Initial release of Day 4 material (outline 004). Targeted for ACSE PIC24 workshop in Toronto on
February 11, 2011. Coverage limited to Labs1-3.
- Schematic and bill of materials for this release are provided in Appendix A & B respectively.

v002 Summary (11 Nov 2011):

— Simplified robot platform: uses 5V PIC24F MCU, single battery pack and L293D motor driver.
— Platform is completely solderless.

- Targeted for ACSE/CETA workshop in Mississauga (Rick Hansen SS) on November 11, 2011

— Schematic and bill of materials for this design are provided in Appendices A & B respectively.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
5



q@ Lab Manual: IEEECETA_WS Day 4 (v002) | ‘i‘?ﬁ‘

Initial Installation/Set-Up

Purpose:

Set-up your PC to run the labs.

Required Equipment & Software:

1. PCrunning Windows 7 or Windows XP Professional with Service Pack2 (SP2) or higher. The PC
should have at least 2 available USB ports.

2. Adobe Acrobat PDF Reader

3. Line Follower Robot Component Kit (see APPENDIX B), includes the “PICkit 3”
programmer/debugger.

4. Day 4 Student files (from CDROM or on-line)
5. Pliers & wire cutter/stripper
6. MPLAB 8 IDE v8.73a (www.microchip.com/mplab) & MPLAB C for PIC24 Compiler v3.30b ”Lite”

version (www.microchip.com/mplabc) - Both are available on the Student CDROM in the
” /Development Tools” sub-folder

7. Basic multimeter (dc voltage/current + frequency counter function)
8. (Recommended) Oscilloscope.
9. (Recommended) Solder Station (suggest Weller WD1001)

Software Installation Procedure:

1. Using Windows’ standard program uninstallation procedure, uninstall any existing MPLAB IDE
and/or MPLAB C for PIC24 compiler versions.

2. Copy all the files/folders from the student COROM to C:\IEEE\IEEECETA_WS

3. Install (i) the MPLAB IDE and (ii) MPLAB C for PIC24 Compiler (use the default paths). Double-
click on the self-extracting .EXEs found in \Development Tools

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Class Folder Structure

Root Folder: “C:\IEEE\IEEECETA_WS"

“C:\|IEEE\IEEECETA_WS\Day 4\Lab1l..Lab4”

Contains the Class Labs — Solution projects/workspaces are provided in the \Solution sub-folder
“C:\IEEE\IEEECETA_WS\Day 4\Presentation & Handouts”

Contains .pdf copies of the slides and lab manual.

“C:\IEEE\IEEECETA_WS \Users Guides & Data Sheets”

Repository for helpful documents while doing the labs, such as MCU data sheets and development
board schematics.

“C:\IEEE\IEEECETA_WS \Development Tools”

Contains the MPLAB IDE and PIC24 C-Compiler, plus any other useful tools used in the training.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Lab 1 — Wiring the Board

Purpose:

To understand the basic fabrication procedure of the line follower robot’s control circuitry.

First, you will wire up the basic circuit as indicated in the schematic (Appendix A) by carefully following
the example fabrication photos in this lab manual. Next, you will insert the Motors, Sensors and battery
pack. Finally, you will use MPLAB and PICkit 3 to program a working .hex file into the PIC24 device to test
your completed circuit. You will confirm the operation of your circuit by controlling both motor’s speed
using the potentiometer. The LEDs will indicate line detection by the Left, Middle and Right opto
Sensors.

Procedure:

1. Using wire strippers/cutter, cut an 18cm piece of Red and Black #22AWG wire from the spools.
Carefully strip off about 1cm of insulation from each end of the wires. Using a soldering iron, tin
the exposed wire (get some help if you are new to soldering), twist the wires together and
solder them to the DC motors as shown here (do not install the wheel):

2. Assemble the control circuit (see Appendix A for the schematic). Suggest you follow the
fabrication in 3 steps, as outlined in the following sequence.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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3. Insert the basic wiring and circuitry as shown. Key component designators are identified (refer
to the schematic in Appendix A). Suggest you use the Acrobat viewer to view the .pdf version of
the lab manual:

R13 C1,C2 R14 R5, C13 ca Cc7 D2 D7 D6

IC2: L293DNE IC1: PIC24FV32KA302

R12, C9, C10 JP1: ICSP Interface Cc3 C6, R6, R4 C5,R3,R1 C8,R2,R8

Design & Assembly Notes/Tips (Refer to schematic in Appendix A):

Wiring: Most of the wires shown are from the wiring kit (pre-cut and bent). Use these to save time.
Some of these wire connections will need to be custom-made.

C1, C9, C7, C8, C5, C6: These capacitors are polarized (i.e. there is a “+” side and a “-“ side). Follow
the schematic carefully and connect the “+” lead to the correct node.

LEDs D8, D2, D7, and D6: The anode-side (positive side) of this component is the longer lead.

JP1 (ICSP Interface): You will need to break off a 6-pin piece from the 36-lead connector in your
component kit.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
9



@ Lab Manual: IEEECETA_WS Day 4 (v002) ~ l l s P

4. Next, break off 3, 4-pin headers, and insert these as shown. Also, insert the 2 motor leads as
shown:

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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5. Finally, connect the Opto Sensors and battery pack (twist the battery pack leads as shown and
make sure the power switch is OFF). Finish off by plugging in the PICkit 3 programmer as

shown:

— - —

s BEEEE EEREE aEsE
L L1 LS

Design & Assembly Notes/Tips:

Why twist the leads? Wires are components! They have resistance, capacitance and inductance.
The leads from the battery pack to the circuit and from the motor driver to the motor can carry up
to 1A, and they require this current to change up/down rather rapidly. Twisting the wires reduces
the inductance of these leads, making it easier for the current to change.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Test the completed assembly by importing/programming a .hex file into the MCU:
Turn on the battery pack’s power switch. The Green LED (LED D8) should light.

Start MPLAB, and set the processor to PIC24FV32KA302 (Configure P Select Device b
PIC24FV32KA302)

Select the PICkit 3 as the Programmer (Programmer P Select Tool P PICKit 3). If MPLAB detects
that a firmware upgrade to your PICkit 3 is available and required, let it install any upgrades.

Successful connection to target will be indicated in the output window:

=

| Output
Build | Yersion Control | Find in Files | PICkit 3

PICkit 3 detected

Connecting to PICK 3.

Firrmware Suite Yersion...... 01,2665

Firrwware bpe.. ... dzPICI3F/24F /24H
PICkit 3 Connected.

Target Detected

Device D Revizion = 00000004

Import the .hex file (File » Import “C:\IEEE\IEEECETA_WS\Day 4\Lab 1\Solution\Lab 1.hex”)
Program the device (Programmer P Program). The program will start executing right after.
The motors should start to spin!

Using a screwdriver, rotate the potentiometer R11 to control the speed of the motors.

Move each opto-sensor ~1/2cm over the black line printed below and verify that it detects the

line by viewing its status on the LEDs (Left-D2, Middle-D7, Right-D6). The LED should light when
over the line. If it doesn’t, this means it could require re-calibration, which you will do in Lab 4.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
12



q@ Lab Manual: IEEECETA_WS Day 4 (v002) | ‘i‘?ﬁ‘

Lab 2 — Creating PIC24 C Projects in MPLAB

Purpose:

To learn how to create a C-based project from scratch for PIC24 using the MPLAB C Compiler for PIC24
(“MPLAB C30”). This project will blink LED D6.

A solution workspace is provided: C:\IEEE\IEEECETA_WS\Day 4\Lab 2\Solution\Lab2.mcw
Procedure:

1. MPLAB IDE and C30 must be installed in their default directories. The hardware for this lab should
already be constructed (see Lab 1). The student CDROM must be copied into C:\IEEE\IEEECETA_WS

2. Using Windows Explorer, copy header file "p24FV32KA302.h" from “C:\Program
Files\Microchip\mplabc30\v3.30b\support\PIC24F\h” to C:\IEEE\IEEECETA_WS\Day 4\Lab 2

3. Using Windows Explorer, copy linker script file “p24FV32KA302.gld” from “C:\Program
Files\Microchip\mplabc30\v3.30b\support\PIC24F\gld” to C:\IEEE\IEEECETA_WS\Day 4\Lab 2

4. Start MPLAB IDE, and create a new c-source code file for the main() function:
a. File» New

b. Type the following source code into the new file (leave out the comments to save time):

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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#include '"'p24fv32ka302.h"
#define MS_DELAY_VAL 100 // Delay parameter

void DelayMs(unsigned int ms); // In-line delay of up to 65536 mS

_FOSCSEL(FNOSC_FRC & IESO_OFF)
_FOSC(POSCMOD_NONE & OSCIOFNC_OFF)
_FWDT(FWDTEN_OFF)

_FICD(ICS_PGx1)

_FDS(DSWDTEN_OFF)

int count;

int main(void)

{
// Initialize LED D6 (RB8)
LATBbits.LATB8 = O; // Initial level to place on pin
TRISBbits.TRISB8 = 0; // Make the pin a digital output
while(1)
{
count++;
LATBbits.LATB8 = 1; // Turn on LED D6
DelayMs(MS_DELAY_VAL); // Delay
LATBbits.LATB8 = O; // Turn off LED D6
DelayMs(MS_DELAY VAL); // Delay
}
}
/*** DelayMs(); Fridtiddtoddtoddtdddtdddtobddtobdddobddtobddtodddtodkddotodkd otk ddokok /

void DelayMs(unsigned int ms)

while(ms--)

{
asm("'repeat #4000'); // 4000 instruction cycles @ 250nS ea. = 1mS
asm('nop™); // instruction to be repeated 4000x

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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c. Save the new file: (File » Save As) “main.c” in C:\IEEE\IEEECETA_WS\Day 4\Lab 2

5. Start the “Project Wizard” which will guide you through the remaining steps to create an MPLAB IDE
project and workspace (select Project P Project Wizard)

rﬂ MPLAB IDE w8.73 - Untitled Workspace
File Edit View |Project | Debugger Programmer Tools C
O = Project Wizard... L}
% Mew..,
Open...
[ # | Untitled Work Close »

After the project wizard opens, click “Next” to continue

6. Inthe “Device” selection box, confirm that PIC24FV32KA302 is selected as device

Praject Wizard )

Step One-: i
Select 3 device EE/@}

[ Device: ]

<Back |

=
2
=2 |
b
i
£

After you do this, click “Next” to continue

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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7. Inthe “Active Toolsuite” selection box, select Microchip MPLAB C30 as the active tool suite.
[ Project Wizard @
Step Two: r.‘
Select a language toolsuite %/@

Active Tookuite: || Microchip £30 Toolsuite

Toolsuite Content

FPLAR

MPLAB C

piler [pic3

[T o T Vo B SO PRy S JU 7 SN T W Tu

g .
MPLAE LINK30 Object Linker [pic30-1d. exe] w3.30

Location

[ 5tare tool locations in project

| Help! MySuite lsntListed |

C:A\Program Files [#86)\Microchiptmplabe303, 30bMbinkpic30-as. exe

[ Show all installed toolsuites

Browse...

[ <Back | Nm>§[ Cancel | | Hebp

If there are red X’s beside any of the toolsuite files (compiler, linker etc), you will need to select the tool
and “Browse” to the location where you instructed the MPLAB Compiler to install the files.

Click “Next” to continue

8. Enter the following project name in the box: C:\IEEE\IEEECETA_WS\Day 4\Lab 2\Lab 2.mcp
Project Wizard Iﬁ
Step Three:

Create a new project, or recorfigure the active project?

@ Create New Project File

]

&
G 7

CAEEENMEEECETA WS\Day 44Lab 2\Lab 2. mep

Reconfigure Active Project
Make changes without saving

Save changes to existing project file

Save changes to another project file

Browsze. ..

' Browsze. .

[<ieac ]

Net> | | Cancel | |

Hep |

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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9. Inthe left pane, navigate to C:\|IEEE\IEEECETA_WS\Day 4\Lab 2. Select each one of the 3
displayed files and press “Add” to add them to the project (main.c, p24FV32KA302.h,
p24FV32KA302.gld):

Project Wizard Iﬁ
Step Four: rl‘
Add existing files to your project

1 IEEECETA WS " A\ CHEEESEEECETA WShDap 440
31 Day 1 A CMEEEMEEECETA WShDay 451
-1 Day2 3 A CAEEEMEEECETA wWSDay 44
he

E-] Lab 1

-] Lab 2

- =20

~AZ] main.c
{-[B p24rvazKAa202 gld

© NG p2dFVaAZKAI0Zh
{_‘-l La
a |

(L I 4 L[} 3

<Back | ﬂext:=§[ Cancel | | Help

10. Click “Finish”. Direct MPLAB to save the workspace as “Lab 2.mcw”. If the project tree isn’t
visible, select from the menu (View P Project). You should see the three files used in this
project.

s

T bomen | oo |

E|C| Lab Z.mcp
|_:_|D Source Files
~[Z] main.c
|:—j||:| Header Files
.|b] pa4rv3ara3z02.h
..... (L1 Object Files
----- 3 Library Filzs
-/ Linker Script
. |2 p2eFv3EKA302.01d
----- (L1 Other Files

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
17



@ Lab Manual: IEEECETA_WS Day 4 (v002) l l s P

11. Connect to the PICKit 3 as the debugger (Debugger P Select Tool P PICKit 3)

-
Py Lab 2 - MPLAE IDE v8.73

Eile Edit View Project Iﬂebugger] Programmer Tools Configure Window Help

Select Tool

Clear Memory

Llab2mev  [=][E@][=]
4 MPLAE SIM

B---l;"l Lab 2.mep 5 MPLAB ICE 2000
E,D ur::e.Files 6 REALICE

o Ii":eardn:rml;ires 7 Starter Kit on Board
. [R] p24FVIKA302K o

-[21) Object Files 9 MPLAB ICD 3

S| Lfbrary Fi[es 10 PIC32 Starter Kit

E-J"'?.L'éki’zig;ztmmgld 11 Starter Kits

|2 Other Files 12 Licensed Debugger

(2 Files ‘4‘: 5¥ﬂ'b°*5|

The output window (View P Output) should show a successful connection to the target via the PICkit 3
(make sure to turn on the power switch on the battery pack).

12. Select/Enable a “Debug” code build:

Lab 2 - MPLAB IDE v8.33

File Edit View Project Debugger Programmer Tools Configure  Window Help

IR IEL TR L N

Lab 2 - MPLAB IDE v8.53

File Edit View Project Debugger Programmer Tools Configure Window Help

|DEH|smE|SAwaAR T

14. If no build errors are reported, program the PIC24 by clicking the Program button Dﬂ

¥ Lab 2 - MPLAB IDE vB.53

File Edit View Project Debugger Programmer Tools Configure Window Help

eI L IE LY LS

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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15. When programming completes, click the Reset button to reset the PIC24 @

Lab 2 - MPLAB IDE v8.53

File Edit View Project Debugger Programmer Tools Configure Window Help

|DEH| smE|ShwaAR ?

16. To run the program, click the Run button ’ T

Lab 2 - MPLAB IDE v8.53

File Edit View Project Debugger Programmer Tools Configure Window Help

BRrIEL L IEL YR LS

f

17. To stop the program, click the Halt button II

Lab 2 - MPLAB IDE v8.53

File Edit View Project Debugger Programmer Tools Configure Window Help

|DEH| smE|ShwaAR ?

|

To startup again, click Reset, followed by Run.

Results:

LED Blinks!

To learn more about debugging in the MPLAB IDE, please refer to the document “16-Bit Language
Tools Getting Started (DS70094E)” guide available in C:\Program
Files\Microchip\mplabc30\v3.30b\docs

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Lab 3 — Motor Control using the PWM Peripheral

Purpose:

Experiment with controlling the motor direction using a working project.The operating modes of the
L293D are reproduced here:

Brake (low-side)

1 0 1 0 1 Forward

1 1 0 1 0 Reverse

1 1 1 1 1 Brake (high-
side)

0 X X High-Z High-Z Coast

Procedure:

1. Start MPLAB IDE

2. Open the solution workspace C:\IEEE\IEEECETA_WS\Day 4\Lab 3\Solution\Lab 3.mcw

3. Build/Program and Run the project. Observe the rotation direction of the motor.

4. Open main.c and find the initialization function Initialize(). Find the 1A/2A and 3A/4A control
outputs (RB13/RB12 and RB15/RB14). Change the setting per the table above and reverse the

direction of the motor.

5. Build/Program and Run the project. Observe the rotation direction of the motor. It should be
reversed.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Lab 4 — Line Detection using the ADC Peripheral

Purpose:

One of the main functions of the line-following robot firmware is to sense a black line path on a white
board. This sensed input is then used to control the motor drive to the 2 rear wheels.

This task may be accomplished using a phototransistor reflective optosensors, such as the QRB1134.
These sensors are typically positioned in front of the robot.

The reflective sensor consists of an infrared emitting diode and an NPN silicon phototransistor mounted
side by side on a converging optical axis in a black plastic housing. The phototransistor responds to

radiation from the emitting diode only when a reflective object passes within its field of view.

The following is a basic circuit using such a sensor:

Icaz
PICZ4FUZZKAZAZ
21 memrw
i \at — RevmnorRERS
—— RAUANIAREF-
——| FBD/ANZ/PEED]
— 1 RE1/ANIFGECI
R4 2— RBZ/ANG
L5 — 1 RE3ANS
470 - Y
1 4 21 Rezents
5 jZf;K . A8 Revianie
* RE4AN1TS
QRB1134 S ERN B
FEFT 220 o 1% | resiPeED:
GRID GHD GHID
Here is a pin-out diagram for the QRB1134:

Schematic Pin Number Function Wire Color
1 (A) Anode Orange
2 (K) Cathode Green
3 (E) Emitter Blue
4 (C) Collector White

The voltage at the sensor output (Pin 3) represents the amount of reflected IR light. In this lab, you will
learn how to use the built-in Analog-to-Digital Converter (ADC) in the PIC24F MCU to digitize this signal
(i.e. turn it into a number that the firmware can use). Black surfaces will absorb light, while white
surfaces will reflect, so we expect the signal to be mostly “high” while the sensor is hovering over a
white background, and going “low” when it hovers over the black line.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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A basic working line detection firmware is provided that emulates a comparator circuit: when the
voltage at Pin 3 of the optosensor drops below a certain threshold, the optosensor’s corresponding LED
will be turned on.

| — e

AMEEE WEEEE EEEEn
L1 LS

The first part of the lab is a calibration step where you will use the PIC24 ADC to measure the sensor’s
voltage response to black/white surfaces (Pin 3) and calculate the optimum trip voltage.

Procedure:

1. Close the previous MPLAB workspace. Turn off the battery to stop the motors, or remove their leads
from the breadboard..

2. Connect the optosensors to the board as shown in in the picture above.

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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3. Start MPLAB and open the workspace “C:\IEEE\IEEECETA_WS\Day 4\Lab 4\Solution\Lab 4.mcw”

4. Open main.cin an editor window. Place a breakpoint on line 89 (the “Decide()” function) by double-
clicking on that line.

85 | Sfinfinite loo
=1 2] while (1

B7 [

B8 et _Inputsai);
g2 D Decide () ;
30 Do _Cutputs :
531 Timing () ;
92 ]

L=l L

5. This breakpoint is where the CPU will halt during debugging, allowing you to examine the ADC
values of the optosensor signals value. A watch window has already been set up to view the 3
variables which will hold the optosensor readings:

- =

= Watch fo o ]

Add SFR| ADTCHITH » | Add Symboll _ SP -
Update kddress Symbol Name Hex Decimal
Left Opto
554 Middle Cpto 0x00OBC 140
858 Right_Opto 0x013F 3149

6. Build/Program a “debug” build:

Select “Debug” Build configuration: Project P Build Configuration » Debug
Select the PICKit3 as Debugger: Debugger P Select Tool » PICKit3
Build the Project: Project P Build All

Program the device: Debugger P Program

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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7. For each optosensor:

a. Hold it ~1/2cm over the black line printed below. Run the code (Debugger » Run ). When
the CPU halts at the breakpoint, record the value in the table below. Next, reset the CPU
(Debugger P Reset P Processor Reset ), move the sensor over the white background and
repeat the measurement (run the code). Record the decimal values in the table below.

Sensor ADC Value (Over Black) | ADC Value (Over White)
LEFT
MIDDLE
RIGHT

8. Use these values to define the appropriate threshold trip values on lines 38, 39 and 40 of main.c

9. Rebuild/Run the code in “Release Mode”

Select “Release” Build configuration: Project P Build Configuration P Release
Select the PICKit3 as Programmer: Programmer P Select Tool P PICKit3
Build the Project: Project » Build All

Program the device: Programmer » Program

Does it work? Position the sensors as you did during calibration. Are there now shadows beneath the
sensors that were not there during calibration? Are you positioning the sensor at the same height?

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved
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Appendix A - Line Follower Robot Electronic Control Circuit Schematic
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Appendix B — Electronic Control Circuit Component Kit

Component Description

MCU 32KB FLASH 2KB RAM 28-SPDIP
PROGRAMMER MCU PICKIT 3
BREADBOARD 2.13x6.496 SLDLESS
WIRE SET 140PC FOR BOARD

CAP CER .1UF 50V 10% AXIAL

CAP TANT 10UF 16V 10% RADIAL

CAP TANT 1UF 25V 10% RADIAL
HOLDER BATT W/COVR 4AA ON/OFF SW
POT 10K OHM THUMBWHEEL CERM ST
BATTERY IND ALKALINE AA SIZE

IC QUAD HALF-H DRVR 16-DIP

143:1 GEAR MOTOR + WHEEL
QRB1134 OPTO Emitter/Detector
CONN HEADER .100 SINGL R/A 36P0OS
RES 10K OHM 1/4W 5% CARBON FILM
RES 1.0K OHM 1/4W 5% CARBON FILM
RES 470 OHM 1/4W 5% CARBON FILM
RES 2.2K OHM 1/4W 5% CARBON FILM
LED 3.1X2MM 650NM RED DIFFUSED
LED 3.1X2MM 563NM GREEN DIFFUSED
#22AWG Black Stranded (6")

#22AWG Red Stranded (6")

MFR Part Number
PIC24FV32KA302-1/SP
PG164130
TW-E40-1020
TW-E012-000
C412C104K5R5TA7200
TAP106K016SCS
T350A105K025AT
SBH-341AS
3352E-1-103LF
EN91

L293DNE

GM8 + GMPW-B
IRROSC-2
PEC36SBCN
CFR-25JB-10K
CFR-25JB-1K0
CFR-25JB-470R
CFR-25JB-2K2
SLR-322VR3F
SLR-322MG3F
3051 BKOO5

3051 RD005

© 2011 Dennis Cecic, IEEE Toronto Section. All Rights Reserved

Digikey Part Number

PIC24FV32KA302-1/SP-ND

PG164130-ND
438-1045-ND
438-1049-ND
399-4484-1-ND
478-1839-ND
399-3528-ND
SBH-341AS-ND
3352E-103LF-ND
N107-ND
296-9518-5-ND
N/A

N/A
S1132E-36-ND
10KQBK-ND
1.0KQBK-ND
470QBK-ND
2.2KQBK-ND
511-1228-ND
511-1226-ND
A2016B-100-ND
A2016R-100-ND

Qty.

= NN

w v o un un wu

Notes
Academic pricing is available from Digikey

Academic pricing is available from Digikey

“GM8PW Deal” (Solarbotics: www.solarbotics.com)

2 sets gives 4 sensors total (Digilent: www.digilentinc.com)

100' Price = $41.23
100' Price = $41.23




